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Abstract

Kaffeine is a Media Player by KDE.


https://www.kde.org/applications/multimedia/kaffeine/
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Chapter 1

Kaffeine Player

1.1 The Start Window

Like many other media players, Kaffeine supports a wide range of video and audio formats as
well as playing audio and video from DVD and CD. Additionally, it supports live Digital TV
playback if your machine has a Digital Video Broadcast (DVB) device plugged into it.

Once Kaffeine starts, it presents a screen with the main functions in the middle, and it’s possible
to switch to other functions via either the menu bar or the left sidebar:
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1.2 Play a File

Playing a video or audio file is as simple as clicking on the Play File button. It will ask you to
select the file to be played, and will begin playing it. Since Kaffeine uses LibVLC for the backend,
it supports all the same file formats as VLC. It also supports opening a list of files to create and
manage playlists.


https://www.videolan.org/vlc/features.html
https://wiki.videolan.org/Playlist/
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1.3 The Playlist Window

Kaffeine supports multiple playlists. Choose the active one with the Playlist selector in the left
sidebar. You can easily drag some files or folders from the file browser and drop it on the playlist
to enqueue or drop it on the player window to create a new playlist. To change a playlist name
edit it and confirm with Return.
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You can find all playlist related functions in the Playlist item from the menu bar and the context-
menu (right-click on playlist).
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Chapter 2

Digital TV Player

2.1 Digital TV configuration

While the basic functionality is useful enough for someone who wants a simple, yet powerful
media player, the best feature in Kaffeine is to use it as a GUI frontend to watch and record

digital TV.

Since Kaffeine version 2.0, the digital TV support uses libdvbv5 and was extended to support
new standards like DVB-T2 and ISDB-T. Extending its support for newer digital TV standards is

now simpler. Also, since it uses the Linux® DVB version 5 AP], it supports frontends capable of

implementing multiple digital TV standards.

Setting the TV configuration on Kaffeine is as simple as open the Television item from the menu
bar and select the Configure Television... option. A pop up window will open, allowing setting

the parameters to be used:

B General Options | B Automatic Recording ¥ Device 1 M Device 2

Recording folder: | /data/records

Time shift folder: | /data/time_shift

Begin margin (minutes): 5
End margin {(minutes): 10
Naming style for recordings: Ytitle

Action after recording finishes.

Scan data last updated on 3 Oct 2017

Update Scan Data over Internet

Edit Scanfile

Use I1SO 8859-1 charset instead of 1ISO 6937: |:

Create info files to accompany EPG recordings: [

<>

<>

® Cancel
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2.1.1 General digital TV settings

The General Options menu allows setting the device-independent settings.
The Recording folder sets the location where all TV program records will be stored.

The xmltv file name (optional) specifies a file name with EPG data that was retrieved via an
external grabber. When this option is used, you'll likely set Disable parsing Electronic Program
Guide (EPG) data from MPEG-TS tables

The Disable parsing EPG data from MPEG-TS tables disables the Electronic Program Guide
(EPG) data to be retrieved from the broadcasted signal. Use it in order to save some CPU time, if
your broadcaster doesn’t send reliable EPG data.

The Time shift folder is used in conjunction with the pause button ( ) ) of the media player
screen. When the button is pressed, a time shift file will be stored at the location pointed by this
menu option.

The Begin margin and End margin options are used to setup a sort of ‘security margin” in order
to avoid losing the beginning and the end of a program, as the time stamps at the program guide
may not be precise. So, it actually starts recording a few minutes before the Start time defined
in the Program Guide. The exact amount of time before is defined via Begin margin. Kaffeine
extends the record by the amount of time defined by End margin after the end of the program.

The Naming style for recordings option is used to setup how Kaffeine will name a program.
Several macros can be used to dynamically change the name of the record:

¢ stitle - Title of the program, as seen at the Program Guide and Recording Schedule menus;

® %day, %month, $%year, %hour, %min, %sec - Fields from the time stamp with represents
the time when Kaffeine starts recording a program;

® schannel - Name of the channel that streamed the program.

The Action after recording finishes option is used to setup an optional command to be executed
when Kaffeine stops recording a program.

Clicking at the Update Scan Data over Internet option makes Kaffeine to check if a new channel
scanning definition file is present at KDE’s site.

Kaffeine uses a file called scanfile.dvb to store a list of known digital TV channels per Country
and City. This file is kept in sync with the contents of the dtv-scan-tables tree, maintained by
LinuxTV community. For more details, please see the dtv-scan-tables wiki page.

When the button is clicked, Kaffeine will download the latest version of the channel definitions
and store on a user-specific local data file, overriding any contents of a previous one.

Please notice that, in order to use the newest definitions, it is required to close the TV configura-
tion dialog and reopen.

The Edit scanfile option allows editing the file, which can be useful to add a new set of channels,
while the upstream file is not updated. If you need to use it, please consider sending an update
to dtv-scan-tables for others to also benefit from the new channel definitions.

The Use ISO 8859-1 charset instead of ISO 6937 option allows selecting the default to be used
on MPEG-TS messages that don’t explicitly set a charset. If not set, it defaults to using ISO-6937
encoding. If set, the default changes to ISO 8859-1.

The Create info files to accompany EPG recordings option enables the creation of ancillary files
for scheduled records with the contents of the program guide for records made via the Program
guide.


https://autoconfig.kde.org/kaffeine/
https://git.linuxtv.org/dtv-scan-tables.git
https://linuxtv.org
https://linuxtv.org/wiki/index.php/Dtv-scan-tables
https://git.linuxtv.org/dtv-scan-tables.git/
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2.1.1.1 Electronic Program Guide (EPG) data retrieval

Most digital TV broadcasters send program information via the broadcast information, encoded
on a MPEG-TS stream. However, some of them use non-standard encodings for those data. As
an example, at the United Kingdom, HD programs EPG data are usually stored using some a
proprietary format. Other providers just don't fill the EPG data, or the information there is not
reliable.

Since Kaffeine 2.0.17, it is possible to disable parsing the EPG data from the broadcasted channels,
using an external program to retrieve them. In order to disable, just set the Disable parsing
Electronic Program Guide (EPG) data from MPEG-TS tables box. You can now set an external
parser to produce a file with EPG data, and use the xmltv file name (optional) to specify the file
name of the produced file. The produced file should use the XMLTV format, as described on its
DTD. See XMLTYV File format for more information.

When Kaffeine is set to use an XMLTYV file, it will automatically detect any file changes on it.
When a change happens, it will open the file and parse its contents, updating EPG data accord-
ingly.

It should be noticed that the XMLTYV file has a table with associates its own internal representation
for channels with the expected channel name at the digital TV broadcasted data. Kaffeine will
only retrieve the EPG data if the channels there match the ones inside Kaffeine’s channel list. So,
you need to ensure that the channels there matches what Kaffeine expects. If it doesn’t match, you
could use a command line XML editor program in order to add the missing channel information.

For example, if you have a xmltv grabber program retrieving the file named origi-
nal_xmltv_file.xmltv, you could use the xmlstarlet program to add missing associations. So, if you
want to associate the XMLTV channel named as channel.foo.uk with a channel whose Kaffeine
name is FOO, you could run this small script:

channel="xmltv.channel.pt"
name="DVB_CHANNEL"
xmlstarlet ed \
-s "tv/channel [@id='$channel’]" -t elem -n display-name \
-v "S$name" original_xmltv_file.xmltv > new_xmltv_file.xmltv
mv new_xmltv_file.xmltv /tmp/new_xmltv_file.xmltv

Then, set Kaffeine to use the new /tmp/mew_xmltv_file.xmltv file.



http://wiki.xmltv.org/index.php/XMLTVFormat
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2.1.2 Configuring digital TV sources

E General Options = B Automatic Recording B3 Devicel B3 Device2 | B Device3 I >

Name: DiBcom 8000 ISDB-T

4 Reset > Move Right
ISDB-T
Tuner timeout (ms): | 1500 o
Source: br-df-Brasilia v
Name: ISDB-T
v 0K © Cancel

The Device tabs have the per-device setup. Usually selecting the country and the city in the
Source combo box (or using one of the Autoscan sources) is enough for non-satellite configura-
tions. The same happens for devices that support multiple TV standards. On those devices, you
need to setup the Source for each TV standard:

Configure Television — Kaffeine

E General Options = [ Automatic Recording B3 Devicel B3 Device2 B3 Device3 I >

Name: Silicon Labs Si2168

< Move Left 4 Reset > Move Right
DVB-C
Tuner timeout (ms): 1500 o
Source: fi-TTV v
Name: Cable
DVB-T2
Tuner timeout (ms): | 1500 o
Source: fi-Espoo w
Name: Terrestrial (T2)

+ 0K ® Cancel

The Tuner timeout specifies the amount of time the channel scan will wait to get a signal lock.
Usually, the default is enough for most devices, but if the device is too slow to lock, such value
can be increased.

10
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The Name specifies the name associated with source that will appear selecting Television item
from the menubar and Channels option, for settings panel.

2.1.2.1 Satellite devices

The configuration for satellite devices (DVB-S, DVB-52) are more complex, as there are different
satellite system arrangements that are possible. Also, on satellite systems, it is usually up to the
device to power up an amplifier located at the satellite dish - called LNBf - via a DC voltage.

Also, as satellite systems use a wide bandwidth and accept signals using different polarities, it is
common to use a protocol - called DiSEqC - in order to select a range of channels to be received.

The first step is to teach Kaffeine about the satellite configuration via the Configuration combo
box:

Configure Television — Kaffeine

B General Options E Automatic Recording = Device 1 = Device 2
Name: Montage Technology M88DS3103

< Move Left % Reset

DVB-S2

Tuner timeout (ms): 1500 v

Use Higher LNBf voltage: (B

Configuration: DiSEqC Switch ~
No Source v
No Source v
No Source v
No Source v

v OK || ® Cancel
The following values are possible:

® DiSEqC Switch - The antenna cable is connected to a DiSEqC switch or the LNBf requires
DiSEqC commands to select a range of channels. This is the most common setting. It allows
having up to 4 satellites connected at the same time, each with its own dish. For each satellite,
you need to set the configuration for the LNBf at the dish pointing to it.

® USALS Rotor - The antenna cable is connected to a single dish with a USALS Rotor, controlled
via DiSEqC. Multiple satellites can be configured, as the rotor will change the dish position
when a different satellite is chosen. You need to specify the position of the dish (latitude,
longitude).

® positions Rotor - The antenna cable is connected to a single dish with a Rotor with a set of
fixed positions, controlled via DiSEqC. Multiple satellites can be configured, as the rotor will
change the dish position when a different satellite is chosen.

® Disable DiSEqQC - The antenna cable is connected to a dish without any elements supporting
DiSEqC. This setup is typically used with multipoint bandstacked LNBf, where all channels
are present at the same time at the antenna cabling.

11
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On a typical satellite system, the LNBf uses the power up voltage to select between a lower
voltage (13V) for vertical or circular right polarization and a higher voltage (18V) for horizontal or
circular left polarization. However, due to cabling loss, sometimes the LNBf doesn’t understand
the high voltage and several channels won’t tune or will tune wrong. So, a few devices offer an
option to increase the voltage to a higher setting (14V or 19V). This is enabled via the tri-state Use
Higher LNBf voltage option. Three values are possible:

® tri-state-Don’t send a command to the device to adjust the voltage level. That’s the default.

* unselected - Use normal values (13V/18V) for the DC voltage. Only select it if the device
supports adjusting the level.

® selected - Use higher values (14V/19V) for the DC voltage. Only select it if the device sup-
ports adjusting the level.

2.1.2.2 Configurations without a rotor

When either DiSEqC Switch or Disable DiSEqC options are used, the first step is to set the
satellite that will be used as a signal source, via a combo box on the right. With a DiSEqC switch,
it is possible to select up to 4 sources. Each with its own LNBf. After setting the source(s), for
each source, click at the corresponding LNBf Settings button to open a popup window to select
the LNBf type inside the dish that corresponds to the source:

LNB Settings — Kaffeine

@ Universal, Europe (0 Big Dish - Monopoint LNBf Low frequency (KHz)

(O Expressvu, North America (* Big Dish - Multipoint LNBf High frequency (MHz)

() Astra 1E, European Universal Ku (extended) ( DishPro LNBf Switch frequency (MHz)

(O Standard () Japan 110BS/CS LNBf Low range: 10800 MHz to 11800 MHz
(O L10700 (0 BrasilSat Stacked High range: 11600 MHz to 12700 MHz
() L10750 () BrasilSat Oi

(O L11300 (0 BrasilSat Amazonas 1/2 - 3 Oscilators

) Astra (0 BrasilSat Amazonas 1/2 - 2 Oscilators

O Invacom QPH-031 () BrasilSat custom GVT

~ OK & Cancel

2.1.2.3 Rotor configurations

When a rotor is used, there is just one LNBf which is shared with multiple satellites. So, the next
step is to select the LNBf type via the LNB Settings dialog.

For USALS rotor, the positioning is done via satellite position (latitude, longitude). So, just select
the satellites that will be used via a combo box and click at the Add Satellite button.

For positions rotor, the positioning is done via a preconfigured position number. So, just select
the satellite position at the number dialog on the left and the satellite via a combo box on the
right and click at the Add Satellite button.

If a satellite was added by mistake, you can select the satellite and click at the Remove Satellite
button to remove it.

2.1.3 Digital TV channel setup

After clicking on the OK button, the next step is to scan for the digital channels, using the Tele-
vision item from the menubar and select Channels option, for settings panel:

12
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Channels Channel Scan Scan Results
B Edit T Remove € Clear Source: Channel  ~  Provider SNR
ISDB-T h BN CNT MO... REDE CNT 13
Channel Number M o start scan BN Cancao ... Harmonic 22
BN REDECN... 1 B8 Cancao ... Harmonic 22
B8 CNT MO... 2 Sc:ntde:jta Ia;; " B Globo 15... 23
updated on a
B3 Globo HD 3 2815 Y| &= alobo 1D 23
B8 Globo 15... 4 signal: 0% B8 Quatro P... Quatro Pode... 14
Record ... SNR: % B Quatro P... Quatro Pode... 14
2 B8 REDE CN... REDE CNT 13
- Record 1... 6 ek ® R d1
0% | |mmneeord e 23
SBT HD&
o Filter i REcOrd - 23
SBT 1Seg® i
= 9= g [ Free to air B Rede Vid... Rede Vida 1... 13
Bl [] radio B Rede Vid... Rede Vida HD 13
B TV Brasil... 10 Ow i BT 15207 22
B3 Rede Vid... 11 (] provider: TR
BN Rede vid... 12 - ' 22
B3 Cancao ... 13 - B3 TV Brasil... 24
B Cancao... 14 Add Filtered B TV Brasil... 24
BN TV SENA... 15 BT CAM T Famars an Y
Add Selected EE— >

B8 TV SENA... 16 e

v 0K @ Cancel

If more then one standard is supported, the Source combo box will allow you to select the one
that will be used to scan. Don’t forget to connect the device’s antenna cable to match the standard
that will be used.

When Kaffeine identifies a channel, it reads a MPEG-TS table called Network Information Table
(NIT), which contains information about channels using different tuning parameters transmitted
by the same broadcaster. On certain networks, it is possible that some tuning parameters to
be stored on several NIT tables (called ‘other NITs"). This is more common on some cable and
satellite systems. By selecting Search transponders for other Networks, Kaffeine is instructed to
wait and parse all other NITs, which may make it to find more channels, at the cost of taking a
lot more time to complete the channel scan operation.

The channel scan operation is started by clicking on Start Scan. Once finished, the discovered
channels will appear on the right. These channels can be copied to the left side by clicking Add
Filtered. It is possible to check the tuning parameters for the channel in the left side by clicking
on the Edit button. Some parameters are adjustable in the window that pops up.

13
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o
Name: Rede Vida HD Number: | 11 >
Sl ISDE-T | | Network ID: 1886 O
Frequency (MHz): 593.143
Bandwidth: 6MHz Transport stream ID: | 1886
Transmission mode: AUTO i =
Guard interval: AUTO Service ID: 60352

Partial reception: AUTO
Sound broadcasting: No
Layer A Modulation: AUTO Scrambled: O
Layer A FEC rate: AUTO

Layer A segments: 0

Layer A interleaving: 0

Layer B Modulation: AUTO

Layer B FEC rate: AUTO

Layer B segments: 0

Layer B interleaving: 0

Layer C Modulation: AUTO

Layer C FEC rate: AUTO

Layer C segments: 0 PMT PID: 80
Layer C interleaving: 0 Video PID: 501

Audio channel: 511

Once the channels are saved, watching TV is as simple as clicking on the Digital TV button in
the main window:

2.2 Watching TV

o
File Playback Playlist Television Settings Help

Search:

g
)
Y | Channel Nu
%+ BB REDE CNT HD 1
~ B8 CNT MOVEL 2
o]
& B Globo HD 3
>
ﬁ B8 Globo 15EG a
Record HD-2
s | = 5
Record 1segl
i - ’ 5
>
L]
o SBT HD-2
= 7
U3
SBT 15egX)
c m g 8
2
] v
= B T/ Rracilia RadaTu a
= »
@
2
4] B [ ] =
® W ® ® 27 > L bl O ® 00:02:19

Kaffeine also allows you to click on the @ button to pause it. With this action, Kaffeine

will record the program and once the ® button is pressed it will start the program from the

L]
point it was paused, this is known as time shifting. There is also a H button that allows

you to quick record and save the program to disk.

14
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2.3 Program Guide

Digital TV channels usually transmit a list of the current and future attractions. This is called
Electronic Program Guide - EPG. The EPG data is captured when a channel’s content is played.
To see the EPG, open the Television item from the menubar and select the Program Guide option:

Program Guide — Kaffeine

Channel EPG language: ~ | Any language
Globo HD
Record HD search:
BANDIEID Start Duration  Title '
13 Nov 2017 08:30:00 01:20 Bom Dia Brasil
13 Nov 2017 09:50:00 01:21 Mais Vocé
13 Nov 2017 11:11:00 00:39 Bem Estar
13 Nov 2017 11:50:00 01:10 Encontro com Fatima Bernardes
13 Nov 2017 13:00:00 00:47 * DFTV - 12 Edicdo
13 Nov 2017 13:47:00 00:33 Globo Esporte
13 Nov 2017 14:20:00 00:38 lornal Hoie

DFTV - 12 Edicao

Telejornal local que mostra as noticias de cada estado. Em pauta a noticia da
cidade, prestacdo de servigo, situa¢do do transito e previsdo do tempo.
Monday, 13 November 2017 13:00:00 -02 - 13:47:00 -02

Genre: News

Country BRA: not rated

@ Close

On some Countries, the EPG may be available in multiple languages. By default, Kaffeine shows
any languages on EPG. If multiple languages are available for a given EPG entry, and no explicit
language content is select, it will prefix the title, subtitle and description data with a 3 letter
language code, as defined by ISO 639-2 specification.

The EPG Language option allows filtering just one language. If enabled, the filter will also be
applied to the On Screen Display - OSD and to any new scheduled recordings. It won't affect
pre-existing scheduled recordings.

]
Besides clicking on the record button H when the live view is opened, Kaffeine also

allows recording a program via the program guide, by clicking on the @ Record Show at
the Program Guide window.

24 Recording Schedule

To see the programs that are scheduled to be recorded, open the Television item from the
menubar and select the Recording Schedule option:

15
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+ New = Edit 0 Remove

Name Channel Start ~ | Duration Disabled

Bom Dia DF Globo HD 6 Jun 2016 02:55:00 01:45:00 BRT Enabled

v OK & Cancel

By clicking one the New button, it is possible to directly define a time and duration for a program
to be recorded. In this case, it won’t use the EPG definitions.

By selecting an existing program and clicking on the Edit button, you may change the start time
and the record duration. You may also program it to be recorded weekly or daily.

By selecting an existing program and clicking on the Remove button, it will remove the program
from the recording schedule.

16
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Chapter 3

The Kaffeine menubar

3.1 The File Menu

File — Open... (Ctrl+O)

E Opens the file dialog and allows you to select a local file to play.
File — Open URL... (Ctrl+U)

@ Open a dialog for text input, so you can enter the URL of a supported external
media stream.

File — Open Recent

E Offers a drop-down list to open a local recent resource. It has an Clear List option
to clear that list.

File — Play Audio CD

¢.
G Select the playback of an Audio CD that should already be in the reading drive.
File — Play Video CD

@ Select the playback of a Video CD that should already be in the reading drive.
File — Play DVD

@ Select the playback of a DVD that should already be in the reading drive.
File — Play DVD Folder

@ Opens the file dialog and allows you to select a DVD folder to play. This folder
contains the raw data found on the DVD.

File — Quit (Ctrl+Q)
E Quits Kaffeine.

17
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3.2 The Playback Menu

Playback — Previous (PgUp)

]

Playback — Play/Pause (Space)

If you playback two streams or more in one session, will select the previous one.

|E| and E icons. With a check box for play a stream or pause what you are
watching. On a television’s stream will proceed to record it, this is known as time shifting.

Playback — Stop (Backspace)

(m]

Playback — Next (PgDn)

Stop a stream what you are watching.

E If you playback two streams or more in one session and you are watching the
previous one, will select the next one.

Playback — Full Screen Mode/Exit Full Screen Mode (F)

™ F@i

==+  and icons. Switch the full screen mode.
Playback — Minimal Mode/Exit Minimal Mode (.)

k i
I:I and =4 icons. Switch the minimal mode. A GUI mode in a window, where
we only have contextual menu and keyboard shortcuts.

Playback — Subtitle

Offers a drop-down list with options related to the subtitle stream(s).

Playback — Subtitle — off/Name-of-subtitle

Select the available subtitle from this drop-down list. These subtitles channels will
vary depending on the content of the source stream.

Playback — Subtitle — Add subtitle file
=
This option is for add a local subititle file through a file dialog.

Playback — Audio

Offers a drop-down list with options related to the audio stream(s).

Playback — Audio — Audio Device

Offers a drop-down list shows the available audio devices. Only available if more
than one audio device was detected when Kaffeine was started.

Playback — Audio — Increase Volume

0 Raise the audio volume. The volume can also be raised by positioning the
mouse over the media player region and scrolling the mouse wheel up.

18
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Playback — Audio — Decrease Volume

{ Lower the audio volume. The volume can also be decreased by positioning the
mouse over the media player region and scrolling the mouse wheel down.

Playback — Audio — Mute Volume

"] and "- icons. Silence the audio volume and return it.
Playback — Video

Offers a drop-down list with options related to the video stream(s).

Playback — Video — Deinterlace

== Offers a drop-down list with available de-interlacing algorithms. Is the pro-
cess of converting interlaced video, such as common analog television signals and
more. See Wikipedia article for more details.

Playback — Video — Aspect Ratio

Offers a drop-down list with available aspect ratios, more an Automatic option. The
aspect ratio of an image describes the proportional relationship between its width and
height.

Playback — Video — Video size

Offers a drop-down list with available video sizes. Change the size of the image by a
percentage, more Automatic and Original Size options.

Playback — Jump to Position (Ctrl+])

> Offers a spin box for setting the desired time point to which you want to go; with
hours, minutes and seconds.

Playback — Skip
Offers a drop-down list with four predefined jump times. With the following options:

Playback — Skip — Skip 60s Backward (Shift+Left)

E It goes 60 seconds back.
Playback — Skip — Skip 15s Backward (Left)

IE It goes 15 seconds back.
Playback — Skip — Skip 15s Forward (Right)

IE' It goes 15 seconds forward.
Playback — Skip — Skip 60s Forward (Shift+Right)

(]

Playback — DVD Menu

@ Start with the original DVD graphic menu. That is explored using the cursor keys
and the mouse. See Wikipedia article for more details.

It goes 60 seconds forward.

Playback — Title

The DVD content is divided into titles to easy navigation. From here you can go directly.

19
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Playback — Chapter

The DVD content is divided into chapters to easy navigation. From here you can go directly.

Playback — Angle

A variant of the chapters: it is possible that they have included several versions (called
‘angles’) of certain scenes. From here you can go directly.

3.3 The Playlist Menu

Playlist — Repeat

—
*~ A check box to replay in a loop the file(s) that are in the playlist.

Playlist -+ Random

:If—h'
¥ A check box to replay randomly the files that are in the playlist until all of them
have been played.

Playlist — Clear

Playlist -+ New

Erase all entries in the playlist.

—I_ Create a new playlist.

Playlist -+ Rename

&

Playlist -+ Remove

Rename the current playlist.

—

[n} Remove the current playlist.
Playlist — Save (Ctrl+S)

=)

Playlist — Save As... (Ctrl+Shift+S)

Save the current playlist.

E‘; Save the current playlist with a new name.

3.4 The Television Menu

Television — Channels (C)

=\, settings panel will appear for set the channels corresponding to your area. See
Digital TV channel setup section for more details.
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Television — Program Guide (G)

o=
-- A window will appear for manage the program guide. See Program Guide section
for more details.

Television — OSD (O)

m Show the on screen display infobox on the playback window during three seconds

with program guide information on the current and next program. Double-clicking on it to
see extended information about the current program, and then click again to remove this
infobox. See Wikipedia article for more details.

Television — Recording Schedule (R)

A window will appear for manage the recording(s) scheduled. See Recording
Schedule section for more details.

Television — Instant Record

|EJ With a check box to verify your selection. Start instantly recording of the stream
that is being played.

Television — Configure Television...

E A window will appear for setting the parameters that manage the DVB device(s).
See Digital TV configuration section for more details.

3.5 The Settings Menu

In order to simplify the use of the Kaffeine, this menu only contains two menu items:

Settings — Configure Shortcuts...

— 8-

= Allows you to enable, disable, and modify keyboard shortcuts. For more informa-
tion, see the section called ‘Using and Customizing Shortcuts’.

Settings — Configure Kaffeine...

E

Opens the configuration panel.

3.6 The Help Menu

Kaffeine has the common KDE Help menu items, for more information read the sections about
the Help Menu of the KDE Fundamentals.
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Chapter 4

Copyright and License

Program copyright 2007-2018, The Kaffeine Authors.

Documentation copyright 2003-2005, Jirgen Kofler kaffeine@gmx.net, Christophe Thommeret
hftom@free.fr, Mauro Carvalho Chehab mchehab+kde@kernel.org

This documentation is licensed under the terms of the GNU Free Documentation License.
This program is licensed under the terms of the GNU General Public License.
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